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I. WBSCM Help Desk Web Self-Service

User Registration Tips

1. When creating a new user, the last name and email address must be the same in WBSCM and
eAuthentication.

2. When adding a new user in WBSCM, the save button should be selected after the roles have
been added to the new user. If the save button is selected prior to selecting the roles, the user
admin can select that new user from the top and select modify to add the roles to the new
user.

3. A user admin can re-send the WBSCM registration email to new users by selecting the user
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in the manage users tab, going to the last tab (data tab), and selecting the re-send registration 
email.

4. Most common issues with registration:

A. The new user selects the wrong link in the WBSCM registration email.
B. The new user does not select ACTIVATE MY ACCOUNT in the eAuth email. This must 

be done within 7 days of the creation of the eAuthentication account.
C. The last name or email address in eAuthentication is different from what is in WBSCM.
D. After creating and activating the new account, the user fails to return to the Registration 

email that they received from WBSCM_User_Registration and click the link in step two 
in order to complete the registration process.

5. Registration emails that are sent to users when their WBSCM profile is created are for that 
specific user only and SHOULD NOT BE SHARED. If a user tries to register using another 
person’s registration email it will not work.

WBSCM Logon

6. Quick Reference for WBSCM Registration

1. Look for the WBSCM Registration email. This email is automatically sent when your 
User Admin creates an account in WBSCM. The Subject line will read Action Required: 
Register USDA WBSCM User Account.

2. Proceed to step 1 in the email. This is a two-step process.

A. Create an E-auth account- Follow the link in this step. You will receive an email after 
you create this account.

B. Activate the E-Auth Account.

To activate the account you will receive an email. Subject Line will read Action 
Required: Instructions to Activate your USDA Account with Level 1 Access.

Click on the link in step 2. This will activate the eAuth account.

3. After you have activated the E-Auth account, you now need to officially link the eAuth & 
WBSCM account. To do this, return to the email with the subject line Action Required: 
Register USDA WBSCM User Account.

A. Click on the link in step 2.
B. Log in using your new login ID and password created in eAuth.
C. Accept the Rules of Behavior.
D. Read the reminder in step 3 of the email.
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7. What do I do if I forgot my password?

1. Go to eAuth webpage (https://identitymanager.eems.usda.gov/iam/im/eems) or select the 
reset password link on the WBSCM landing page.

2. Select the I Forgot my Password link.
3. Click Continue.
4. Follow instructions to reset password.

The eAuthentication application, which is used to access all USDA applications, does not
operate correctly with Internet Explorer 7 when registering new users or updating existing
users. It is recommended that you use Internet Explorer 8 or higher.

Note: eAuthentication Password Policies

Passwords must have a minimum of 12 and maximum of 24 characters.
Passwords must include at least one each of the following: uppercase, lowercase, a
number, and one of these special characters: ! # $ % = + : ; , ? ~ * -
Spaces or dictionary words are not allowed.
Passwords must be changed every 60 days.
Your previous 24 passwords may not be re-used.
Inactive accounts are disabled after 400 days.
After 3 failed login attempts, the account is locked for 60 minutes and this lock cannot
be overridden.

8. WBSCM Email Change and Password Recovery

If you change your email address, remember to update both your E-Auth and WBSCM 
profiles. If you try to reset your password and do not have access to your old email account,
you will be required to create a new E-Auth ID and WBSCM account.

9. I am having problems with the log-in screens rendering correctly.

Currently, for WBSCM, Internet Explorer 7 or Internet 8/9 in compatibility mode must be
used for optimal performance. To set the Internet Explorer browser to view WBSCM in the
Compatibility View do the following:

1. Go the Tools tab at the top of the browser.
2. Click Compatibility View Setting.
3. In the Add this website text box, type usda.gov and click Add.
4. Click Close.

Click this link for step by step instructions: 
http://www.fns.usda.gov/sites/default/files/wbscm/WBSCM-Internet-Explorer-Browser-
Settings.pdf
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User Admin/Org Admin/Roles

10. How does a user get access allowing them to create requisitions?

A User Administrator for the user's organization (e.g. FNS, SDA/ITO, or RA) must 
assign the Order Manager role to the user.

11. Can an SDA User Administrator grant their RA users access to create orders?

An SDA User Admin cannot create an RA Order Manager. If there is not an RA User
Admin or Org Admin for the particular RA Organization, then the SDA User Admin can
create an RA User Admin for that particular RA Organization. The User Admin for the RA
organization can then add the RA Order Manager Role to themselves or any other user in
their organization.

12. How do I create users and assign role?

The User Admin role allows each organization to add, remove, and modify users within 
their organization (including their own roles). After entering the user’s information,
remember to assign roles by clicking on the roles tab and clicking Save after you have 
made your changes. Once a user is created, you will have the option to modify them by 
clicking the modify button.
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13. What do I need to do to add a new ship-to for my SDA organization?

In order to add a new ship-to to WBSCM, you need to complete and send in the FNS-7
form (http://www.fns.usda.gov/fdd/forms) to WBSCM-Ship-To@fns.usda.gov.

14. Can I view all the ship-tos that are assigned to my organization?

Yes. SDAs, RAs, and Co-Ops can run the Domestic Ship-To Contacts Report to see all
ship-tos that are assigned to their organization.

15. Is there a faster way to assign ship-tos to my RAs?

Yes. You can use the Mass Assign Ship-To option to assign a ship-to to multiple RAs at a
time.

16. I have a user who cannot see reports. What do I do?

Usually the user has not received the View-Only role. This role is used for viewing reports 
and all users need to have this role. You may also have a user who only reviews reports and 
having just this role allows them to do this without access to create new transactions.

17. I have a Supplier WBSCM Account from USDA. I am also a receiving organization 
that will be receipting and viewing order reports in WBSCM, do I need two logins?

Yes, you need to have two separate eAuths and WBSCM accounts. You must register for
WBSCM twice.

18. How can an RA assign a default "Deliver to" (i.e. a ship-to) location?

There is no way to assign a default “deliver to” for an RA. An RA can remove all non-
relevant deliver-tos from the RAs thereby reducing the number of ship-tos they have to look
through. Maintain ship-tos by being an Org Admin and go to: Admin > Organization
Maintenance > Update RA Org > Relationships > Has Ship-To (from drop-down), and
remove any ship-to locations that are not needed.

19. When creating a new RA user what do I put in the FIPS and RA Identifier ID 
Number fields?

These fields are a carryover from ECOS and are both optional.
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20. When the SDA uploads RA updates what happens to the existing data?

WBSCM will only update the changes while maintaining the rest of the existing data.

Ordering/Cart

21. If the SDA/RA clicks Draft, do they click Order or what do they need to do to save it 
in a “Draft”?

They must click Order. They can then pull the draft up by using My Transactions when
they need to.

22. Will the SDA/RA be able to modify their requisition or order?

Once they approve the requisition or order, they cannot make changes. If the SDA returns
the order to the RA, then they can make some limited changes.

23. If multiple people at an RA are logged in at the same time, does that affect ordering? 
For example, if one person were ordering meat while another person were ordering 
vegetables, would that affect anything in WBSCM?  

More than one user can place orders at the same time, but once the order using the last of 
the entitlement has been placed, no more orders may be submitted by either user. Users 
within the same organization should not try and place orders for the same commodities at 
the same time.

24. How does a user change a Direct Delivery order?

SDA
Changes can be made to the requisition in the consolidated workbench or the requisition
can be returned to the RA to allow them to make the changes.

RA
After receiving the returned requisition from the SDA, Go to: Operations > Order
Processing > Order Management > Domestic Order Entry > My Transactions. Then find
your order using the search criteria.

1. Click the order number when it comes up.
2. When the order is displayed in the cart, click Change.
3. Choose the new delivery location and change quantities. Note: only the SDA can 

change delivery dates.
4. Change status to Ready for Approval.
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5. Click Update.
6. Click Save.

25. How do I print my order information?

After logging into the WBSCM system: Operations > Order processing > Order Management
> Domestic Order entry.
Please search for your order number under My Transactions Tab, open the order, click on
the 'print' button on the screen, you will be able to print the sales order.

Suggestion:
You will be able to print the order from the "check out" list, immediately after the order is
created.

26. How can I easily receipt multiple line items on an order?

1. Enter relevant information at the header level.
2. Click Receipt All, thereby copying the information to each line and making each line's 

good quantity the total ordered quantity.
3. Go to the line(s) for which you did not receive the total ordered quantity and enter the

actual good quantity received plus any damaged, if applicable.
4. Click Submit.

It is possible to use both the receipt all functionality and changing individual lines.
However, to do so, Receipt All must be selected before the individual lines are adjusted, 
otherwise, the Receipt All functionality will overwrite your values.

27. How to receipt when there is an open quantity?

Sometimes while receipting, you may only have a partial load to receipt. This causes you to 
have a receipt with an open quantity. This means that you can go back into the receipt to 
update information if necessary until the load has been fully receipted. Anything that was 
entered into the goods receipt the first time will not be replaced.

1. Note how much has already been receipted and what is left to receipt, so that you do not
produce a goods receipt with duplicate quantities. In the screen shot below, you can see 
that the previous quantity receipted shows in the Prev Qty field and the amount left to 
receipt shows in the Open Qty field.

2. You can only receipt what is noted in the Open Qty field. Remember not to re-enter data
that has already been receipted.
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28. How to receipt replacement orders that were rejected?

1. Proceed to receipt the order as normal.

A. If you originally rejected 100% of the line item, then you will no longer need to re-
enter it again under the Rejected Qty field. Enter the amount under either Good Qty or
Good Qty (in CS) or both (depending on whether it is variable or non-variable) and
complete your goods receipt.

B. If you partially rejected a line item and partially receipted the rest, then you will see 
your partially receipted quantity amount under the Prev Qty (previously receipted)
field. Please match the quantity under the Open Qty field (amount remaining for you
to receipt) and complete your goods receipts by entering that under either Good Qty or
Good Qty (in CS) or both (depending on whether it is variable or non-variable).

2. You may want to add comments to notate any special notes concerning the replacement 
order.

3. Submit the receipt as normal.
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29. I am trying to check my orders by running the order status report, but when I put in
the ship-to or sold-to I get the message, "Your Query returned no results! Please check
your input and try again." I have plenty of orders in and the ship-to showing is my
largest agency, so there should be tons of deliveries going there. Am I doing something
wrong?

On the Order Status Report, the SDA Organization is always the sold-to. The ship-to will
be the organization that will physically receive the order (e.g., a warehouse). Please make
sure that you have entered the correct ship-to number in the input field. Then rerun the
report.

30. How do I use the filter feature in the CWB?

Use the filter feature on the right hand side to place a blank line at the top of the
consolidation table. Enter information into the blank line within the column you wish to 
use as your filter. For this example, use the FTL quantity in the Quantity column. Press 
Enter. You will now only see those requisitions that are FTL. To remove the filter, click
the Delete Filter link.

31. Why can’t my RA see the changes I’ve made to an order/requisition returned by FNS?

After making changes to a returned order in the Returned FNS Orders screen, be sure to
click the Update Order/Req button to update the order with the changes you made. This
will also flow changes back down to the original requisition. When your RAs or Co-ops
navigate to the Domestic Order Entry screen and display their requisition, they will be
able to see changes you made to it as well as any comments explaining those changes.

Remember to click the Submit Order for Approval button to submit your updated orders
back to FNS. Note: if you do not submit your changes, they will not be made.
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32. If the SDA/RA adds materials to their cart and then logs off of the system, will it save
the items in the cart?

No.

Catalog/Requisitions/Entitlement

33. I am unable to view my catalog or commodities in the catalog? What do I do?

If you are the SDA

Confirm that FNS has created a catalog for your SDA organization and has assigned the
correct programs.

If you are the SDA & creating a catalog view (Cview) for your RAs

Process the Cviews as it has been instructed in the work instruction Create RA
Catalog Views.
Make sure the Cviews are created with direct relations to your product catalog.
Check to see if the Cviews are not down (on a locked session).
Check to see if the Cview is selected by default when you process it.

Check to see if products are selected under the material hierarchy (Ent/ Bonus).
Check to see if RA organizations are selected under the Cviews, if not make sure 
your RAs are associated to the appropriate Program(s) under the Organization 
Maintenance screen.
Make sure the view is up to date and running (you could make sure by clicking the
update button before and after you process a Cview).

Make sure dates are selected for the product on the delivery date table (it is highly 
recommended that you refresh the delivery date table frequently by de-selecting and
re-selecting delivery dates and saving them afterwards).
Make sure the lead times are within a reasonable time frame.
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34. Why can’t I see and activate the new materials added by FNS to the master catalog in
my catalog view?

Always click the Save View and Organization button even before making any changes to
the catalog view. This is recommended so that any new materials added by FNS to the
master catalog will become available in the catalog view for activation.

35. When placing a requisition, what happens if you select cancel on the confirmation 
screen asking if you want to send the order? Does it take you back to the order screen
or does it cancel everything you’ve done and empty your cart?

It goes right back to the cart and picks up where you left off – so you can make changes
and place the order or cancel.

36. When an SDA/RA saves a requisition as a draft, does it reflect in the entitlement
report?

Draft requisitions will decrement entitlement. If you know you will not be using a
particular draft requisition, then you should cancel the requisition. Only in Cancelled
status will it not impact entitlement reporting.

37. How can I stop receiving the Sales Order/Requisition change emails?

To opt out of receiving Sales Order or Requisition Change emails, check the “Opt out
from order change notification” checkbox in the Maintain User Profile screen.
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38. What is the best way to distribute quantities to more than 10 RAs?

It is recommended that you run the Process Orders in Background job.

The SDA may also submit additional redistribution background tasks for processing 
(for other sales orders) although the first task must complete before subsequent ones 
execute.
An email notification will be sent to the SDA user that submitted the job, stating the 
redistribution job has completed.

39. Can I search for a single material in the Domestic Order Entry screen or Manage RA 
Catalog Views?

Yes. By entering the material number in the Quick Search box or Find Product search box 
and then picking the material/program.

Note: this method only applies to domestic direct-ship ordering.

40. Is the entitlement reporting in real time?

Yes. However, if the SDA is updating the amount an RA has for ordering (planning
function), the entitlement available for the RA will be updated during the overnight batch
program.

41. If the SDA/RA places a requisition or order, can they run their report immediately
after and see the updated available entitlement amount?

Yes.

42. Is there anywhere in the ordering process that shows what entitlement is remaining to
be spent without having to run the entitlement report?

You can select the entitlement link at the top of the order processing screen. It requires
input to run the entitlement/bonus report, but it allows you to see information during the
ordering process rather than having to go to the reports tab.

43. How are commodity values updated in WBSCM?

Open sales orders are updated weekly, based on the average purchase price for the
appropriate material purchased the prior week. Once a sales order has been purchased, it
receives a final price based on the average and is not updated again unless there is a
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modification to the sales order/purchase order. In that situation, the last average price is re-
calculated based on the new average price.

44. Can we see what is Draft and what was submitted as an actual order?

Yes. Both the entitlement/bonus report and the req status report will reflect the appropriate
status of a req/order.

45. On the Entitlement/Bonus Detail report, I would like to see all the rows of information
that are available. How can I do that?

Displaying 1000 rows at a time is the standard functionality in this type of report. The
output will contain all the records, but it displays only 1000. In order to see the next 1000
records, you select the Next button at the bottom the screen.

If you want to see all the records for a particular report at a time, go to that report, then
Settings on the right hand side, select the Display tab. Enter "-1" (i.e. negative one) for
number of display rows. Then it displays all the rows. Depending on the size of the
report, you may experience slower response time when pulling all the available rows
rather than using the default number and the Next button.

46. I am an SDA and I want to run the Entitlement/Bonus summary report for all my RAs.
How do I do this?

Remove the SDA/RA default in the selection criteria area.

47. If I change the entitlement notification or stop percentage as an SDA, how long do my 
RAs have to wait before they can see the change?

The change is immediate.

48. I am consolidating requisitions in the consolidation workbench. I have some
requisitions that I would like to decline. I have selected them and they have moved to
the bottom of the screen under Declined. How do I finish declining them?

Once you have declined the requisition and it has moved to declined tab located near the
bottom of the screen, you need to select the Update Requisitions button, and then select
Yes when you see the pop-up question that you are no longer able to update requisitions. 
Once you navigate out of the workbench, if you re-enter the same material, you will no
longer see the requisitions that are being declined.
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49. Can I create a new requisition from the consolidated workbench screen as I could in 
ECOS?

In WBSCM, you cannot create a new requisition in the workbench area. If you want to
add a new requisition for a particular material, you can either change an existing
requisition in the workbench to the delivery date/delivery location/quantity you desire or
as an SDA you can create a new requisition on behalf of one of your RAs.

50. Why are requisitions that have been returned by the SDA still counting against
entitlement?

The requisition will still draw down on entitlement until the order has been cancelled.

51. I can’t see the new RAs in the entitlement budget screen.

New RA organizations that are created in WBSCM will not automatically appear in the
entitlement budgeting views. They must be added either using the New Record button or
the Upload button.

52. With the Redistribution/Redonation Report, how can I see all documents based on only 
a delivery date search? 

Enter 5* in the Sales Doc field or 1* in the Requisition field. Otherwise, results will only 
display Re-distribution /Redonation docs.

53. How do I cancel a previously created redistribution?

1. Click the blue box beside the redistribution order you want to cancel.
2. Click the Cancel Redist. button to cancel your redistribution order
3. Click the Yes button to confirm that you want to cancel the redistribution document.
4. A confirmation message indicating that your redistribution credit order (ZRCR) and 

redistribution order (ZRE) were cancelled is displayed at the top of the screen.

Complaints/Recalls

54. I have not received any response from FNS regarding a complaint I entered into 
WBSCM recently. What do I do?

Check that the complaint record entered into WBSCM has been submitted to FNS.
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55. How can I receive recall notifications?

To receive recall notifications, you need the Recall Contact role. You will then need to 
update your recall contact preferences by going to the Maintain User Profile view to set
the methods you wish to be contacted on. WBSCM does not default contact preferences 
so it's the responsibility of the user to set this up.

Note: A recall specialist will not receive notification unless they have the Recall Contact
role.

Multi-Food

56. How does a user know that their order has been processed and received by the
warehouse?

You will not receive an email when you create your order. You will receive an email from 
the system when the warehouse ships your order. You should expect an email (or several
emails) a few days before the items arrive.

57. How does a user change a multi-food order out of a national warehouse?

To change an order, go to: Operations > Order Processing > Order Management >
Domestic Order Entry > My Transactions. Then find your order using the search criteria.

1. Click the order number when it comes up.
2. When the order is displayed in the cart, click Change.
3. Choose the new delivery date, change quantities, delete or add commodities for your

order. Note: the date must be more than 7 business days in the future.
4. Click Update.
5. Click Save.

Your order should be updated.

58. How can I make sure that I have the most current delivery date information when I’m 
putting in orders?

To ensure that you are pulling up the most up-to-date delivery date information for your
delivery location, follow these steps in this order.

1. Select the delivery location.
2. Click the Update button (very important).
3. Select a program.
4. Select a product and place it in the cart.
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5. Select a delivery date.
6. Submit your order.

Note: WBSCM defaults to the next soonest delivery date. If you want to select a date that 
is further out (while within 30 business days), you can select it from the dropdown before
saving your order.

59. How can I get multi-food pending replenishment information?

Multi-food pending replenishment information can be found by clicking on the hyperlink
quantity in the Pending Replenishment column of the multi-food catalog. If inventory levels 
are zero and there is no pending replenishment quantity listed, please contact your regional
office and have them find out the products status from the appropriate warehouse manager.

60. Where can I see net weight on a multi-food report?

Execute the PDF for the Value of Materials Received to view the net weight column.

System/Data

61. Is there a current list of material numbers, SDA codes, and new entity codes/ship-to 
locations?

Yes. The Crosswalks for commodity codes, SDA codes, and entity codes are located on
the Food Distribution website located at: http://www.fns.usda.gov/fdd/wbscm-
crosswalks.

62. Will WBSCM kick you out after a certain amount of inactivity? If so, what is the time
limit?

Your session will time out after 30 minutes of inactivity.

63. Why am I am having problems with the ordering screens rendering correctly?

Check the version of Internet Explorer you are using. Currently, WBSCM does not
always render correctly with IE8. Go to Tools and enable compatibility mode. Contact 
the main WBSCM Help Desk (877-927-2648 or WBSCMhelp@ams.usda.gov) if you 
need help.
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64. Where is the commodity file in WBSCM?

Select Admin > Master Data > Material > List of Materials, then type in Plant 1000 to
remove material redundancies in the report.

65. I receive a Print Version Failure error when using the Print Version button. What do I
do?

Export the data into Excel and print the data from Excel.

66. How do I adjust the size of my print output?

You can right-click in the order area, choose Print Preview and adjust settings there until 
you get something you can use. Alternatively, you could choose the Print button and
adjust the print settings on the subsequent pop-up screen. 

67. How do I add a column to a WBSCM report?

1. Execute the report.
2. Scroll to the far right and click the Settings link.
3. Click the Columns Selection tab.
4. Select/highlight the desired field listed under the Hidden Columns box and click the

Add button.
5. Click the Save As button.
6. Type desired new report name in the Description field and click the OK button.
7. Click the Apply button.

68. After selecting Export to Microsoft Excel, I received a warning message advising that
the file was not in Excel format. What do I do?

1. Open the downloaded file using Microsoft Excel.
2. Select File > Save As.
3. Select the desired Excel format to save the file (e.g. xlsx, xls, csv, xml, html, txt, pdf).

69. How do I create and use report variants?

To create variants:

1. Define your Search Criteria.
2. Click Show Variants. Variant Maintenance will appear.
3. Enter a name for your report beside Variant (i.e. RA_1 MultiReq).
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4. Save.

To use variants:

1. Click Show Variants. Variant Maintenance will appear. Ensure the Variant field is
blank.

2. Enter your report name.
3. Click Load.
4. Click Execute.

Or:

1. Click the box to the right of the Variant field. Variant Search & Select will appear.
2. Ensure the Variant field is blank.
3. Click Start Search.
4. Select the desired variant.
5. Click OK.
6. Click Load.
7. Click Execute.

WBSCM Help Desk Web Self-Service

70. Do all WBSCM users registered into Service Now have access to the ESS module?

Yes. All users will have access to the Self-Service application.

71. What do I use to logon to the Self Service web site?

You must use the same email address that is used on your eAuth and WBSCM accounts.

72. How do I get my initial password for the self-service site?

You can go to the self-service page and do the following to get an initial password:

1. From the Service-Now login, click the "Reset your password here" link. The form 
prompts you for your user ID and email, which for WBSCM users is the same.

2. If there is a matching user record found, the system will send a password reset email 
containing a temporary password.

3. Then you use the temporary password from the email to log in and you will be
prompted to create a new permanent password.
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73. What happens if I forget my password?

If you forget your password, go to the Service-Now logon page and click the "reset your
password here" link. Then follow the same steps as listed above to get a new temporary 
password.

74. What can I do from the Self-Service web site?

From the self-service web site you can create a new incident, review your list of open
incidents, and look at the detailed information on any of your open incidents.


